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АННОТАЦИЯ 

Документ предназначен для пользователей компонента SPLAT.MD, выполняющих функции 

администрирования для устройств, работающих под управлением операционной системы Check 

Point SecurePlatform. 

Состояние документа — февраль 2007 г. 
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1. ВВЕДЕНИЕ 

1.1. Данное руководство содержит информацию необходимую для эксплуатации продукта 
SPLAT Management Dashboard (компонента SPLAT.MD).  

SecurePlatform - это операционная система компании Check Point Software Technologies, 
обеспечивающая надежное функционирования других продуктов Check Point с максимальной 
производительностью. 

Программное обеспечение SPLAT.MD было создано для упрощения задач 
администрирования SecurePlatform и снижения совокупных затрат при ее эксплуатации. 

SPLAT.MD предоставляет как минимум следующие возможности в графическом интерфейсе 
пользователя: 

– файловые операции; 
– удобный экспорт конфигурации управляемых устройств; 
– удобный запуск процессов в отладочном режиме; 
– одновременный доступ к устройствам управляемым разными серверами SmartCenter. 

2. УСТАНОВКА КОМПОНЕНТА SPLAT.MD 

2.1. Требования к вспомогательному ПО 

SPLAT.MD может эксплуатироваться на любой версии ОС Windows, на которой 
поддерживается: 

– Java Runtime Environment (JRE) Sun 1.4.2 и выше; 
– Java Runtime Environment (JRE) IBM 1.4.2 и выше. 
JRE должно быть установлено до установки SPLAT.MD. 
 

2.2. Требования к сетевой среде 

SPLAT.MD использует протокол SSH для управления устройствами SecurePlatform. 
Для функционирования SPLAT.MD необходимо убедиться, что правила на межсетевых 

экранах, списки управления доступом на маршрутизаторах (ACL), и т.п. разрешают соединения 
SSH (TCP порт 22) с рабочей станции, на которой установлен SPLAT.MD к каждому управляемому 
устройству. 

2.3. Использование Мастера Установки 

Для начала установки запустите SplatMDsetup.exe. Следуйте инструкциям на экране. 
SPLAT.MD можно использовать непосредственно после завершения работы Мастера 

Установки. 

2.4. Первый запуск 

При первом запуске SPLAT.MD устанавливается пароль. Настоятельно рекомендуется 
использовать стойкий к подбору пароль поскольку он защищает файл %HOMEDIR%\devices.enc, в 
котором находится зашифрованная информация о конфигурации, включая пароли к управляемым 
устройствам! 

Примечание. Расшифровка файла невозможна в случае утери пароля. 

3. НАСТРОЙКА 

3.1. Настройка параметров 

Для изменения параметров выберите пункт меню File -> Preferences. Появится окно с 
настройками: 
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Следующие параметры могут быть изменены: 

Socket timeout – время ожидания установки соединения в секундах. 
Connection timeout – время ожидания данных в установленном соединении. 
Disk free – максимально возможное использование диска в процентах. 
SSH Enable Strict Host Key Checking – включает опцию отображения SSH host 

fingerprint для вновь добавленных устройств. 
Ключи управляемых устройств находятся в файле  

%HOMEPATH%\ssh_known_hosts\known_hosts. 

4. ЛИЦЕНЗИРОВАНИЕ 

4.1. Без лицензии возможно управление только одним устройством. 
Для того чтобы добавить лицензию выберите пункт меню Help -> License -> Activate License и 

укажите путь к файлу license.lic. 
Выберите пункт меню Help -> License ->  License Information чтобы убедиться в успешном 

добавлении лицензии.  

5. ДОБАВЛЕНИЕ УПРАВЛЯЕМЫХ УСТРОЙСТВ 

5.1. С помощью компонента SPLAT.MD вы можете управлять любым типом устройств 
поддерживаемых SecurePlatform. Например, SmartCenter, gateways, Log servers, и т.п. Однако не 
все функции применимы  ко всем типам устройств. Например, к любому устройству применима 
функция “Process List”, в то время как функция запуска HTTP Security Server лишена смысла на 
сервере SmartCenter. 

5.2. Существует несколько способов добавления управляемых устройств: 
– нажатием правой кнопки манипулятора графической информации «мышь» (далее по тексту 

мышь) по закладке “Devices”; 
– выполнением пункта меню Device -> Add Device; 
– нажатием левой кнопкой мыши по кнопке “Add Device” на панели инструментов. 
Далее необходимо ввести запрашиваемую информацию: 
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Версия управляемого устройства должна быть указана корректно для правильного 

функционирования.  
Идентификатор вводимого пользователя должен точно соответствовать идентификатору 

действующего пользователя SecurePlatform использующего оболочку bash.  
Примечание. Пользователь созданный командой adduser по умолчанию использует 

оболочку cpshell. 
Необходимо вручную отредактировать файл /etc/passwd следующим образом: 
root:x:0:0:root:/root:/bin/cpshell 
shutdown:x:6:0:shutdown:/sbin:/sbin/shutdown 
halt:x:7:0:halt:/sbin:/sbin/halt 
nobody:x:99:99:Nobody:/:/sbin/nologin 
vcsa:x:69:69:virtual console memory owner:/dev:/sbin/nologin 
ntp:x:38:38::/etc/ntp:/sbin/nologin 
rpm:x:37:37::/var/lib/rpm:/sbin/nologin 
pcap:x:77:77::/var/arpwatch:/sbin/nologin 
admin:x:0:0::/home/admin:/bin/bash 

6. СОЗДАНИЕ РЕЗЕРВНОЙ КОПИИ 

6.1. Для создания резервной копии конфигурационных данных необходимо сохранить файл 
%HOMEDIR%\devices.enc file. 

7. УПРАВЛЕНИЕ УСТРОЙСТВАМИ SECUREPLATFORM 

Выбор устройства и требуемой функции выполняется одним из указанных способов: 
– нажатием правой кнопкой мыши;  
– выполнением пункта меню “Task-> Menu”; 
– нажатием кнопки на панели инструментов. 

7.1. Software inventory 

Функция предназначена для просмотра списка пакетов rpm, установленных на управляемом 
устройстве. Вызов функции предоставляет пользователю список пакетов rpm, установленных на 
устройстве в виде таблицы. Информация в таблице может быть рассортирована по любой из 
колонок (сортировка выполняется после щелчка мыши по заголовку любой из колонок). В случае 
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необходимости информация может быть экспортирована в текстовый файл. Для этого необходимо 
нажать правой кнопкой мыши по любой из строк таблицы. 

7.2. Process list 

Функция предназначена для просмотра списка процессов на управляемом устройстве. 
Вызов функции предоставляет пользователю список процессов запущенных на управляемом 
устройстве в виде таблицы. Информация в таблице может быть рассортирована по любой из 
колонок (сортировка выполняется после щелчка мыши по заголовку любой из колонок). В случае 
необходимости информация может быть экспортирована в текстовый файл. Для этого необходимо 
нажать правой кнопкой мыши по любой из строк таблицы. 

 

7.3. File Operations 

Функция предназначена для: 
– навигации по удаленной файловой системе; 
– редактирования удаленных файлов; 
– просмотра удаленных файлов; 
– загрузки удаленных файлов в локальную файловую систему. 
В нижней части окна “File Operations” доступен выпадающий список предопределенных 

файлов. 

 

7.4. Launch PuTTY 

Функция предназначена для запуска внешней программы PuTTY, которая может быть 
использована для терминального доступа к управляемому устройству. 

7.5. Upload file 

Функция предназначена для загрузки файла из локальной файловой системы в удаленную. 
Функция предоставляет пользователю выбрать исходный файл в локальной системе и целевой 
каталог в управляемой системе. 
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7.6. Export Configuration 

Функция предназначена для запуска утилиты upgrade_export на управляемом устройстве и 
загрузки экспортированной конфигурации на локальную файловую систему. Файл с 
экспортированной конфигурацией может быть использован для клонирования управляемых 
систем или резервирования.  

7.7. Web UI Оperations 

Функция предназначена для включения и выключения сервиса SecurePlatform HTTPS web 
server на управляемом устройстве. Также доступна возможность выбора порта. Включив сервис 
SecurePlatform HTTPS web server, пользователь может подключиться к нему, используя Internet 
Explorer. 

7.8. Hardware Inventory 

Функция предназначена для сбора базовой информации об аппаратном обеспечении 
управляемого устройства. Вызов функции предоставляет пользователю информацию об 
аппаратном обеспечении управляемого устройства. В случае необходимости информация может 
быть экспортирована в текстовый файл. Для этого необходимо щелкнуть правой кнопкой мыши по 
любой из строк. 

 

7.9. Network -> Interface Information 

Функция предназначена для получения информации о настройках сетевых интерфейсов 
управляемого устройства. Вызов функции предоставляет пользователю информацию о сетевых 
интерфейсах и их характеристиках на управляемом устройстве в виде таблицы. Информация в 
таблице может быть рассортирована по любой из колонок (сортировка выполняется после щелчка 
мыши по заголовку любой из колонок). В случае необходимости информация может быть 
экспортирована в текстовый файл. Для этого необходимо щелкнуть правой кнопкой мыши по 
любой из строк таблицы. 

 

7.10. Network -> Route Information 

Функция предназначена для получения информации о таблице маршрутизации 
управляемого устройства. Вызов функции предоставляет пользователю список маршрутов 
запущенных на управляемом устройстве в виде таблицы. Информация в таблице может быть 
рассортирована по любой из колонок (сортировка выполняется после щелчка мыши по заголовку 
любой из колонок). В случае необходимости информация может быть экспортирована в текстовый 
файл. Для этого необходимо щелкнуть правой кнопкой мыши по любой из строк таблицы. 

 

7.11. Network -> Netstat  

Функция предназначена для получения информации об открытых сокетах на управляемом 
устройстве. Вызов функции предоставляет пользователю информацию об открытых сокетах и их 
характеристиках на управляемом устройстве в виде таблицы. Информация в таблице может быть 
рассортирована по любой из колонок (сортировка выполняется после щелчка мыши по заголовку 
любой из колонок). В случае необходимости информация может быть экспортирована в текстовый 
файл. Для этого необходимо щелкнуть правой кнопкой мыши по любой из строк таблицы. 

 
 

7.12. Network -> Arp Table 

Функция предназначена для получения информации об arp таблице управляемого 
устройства. Вызов функции предоставляет пользователю список arp записей на управляемом 
устройстве в виде таблицы. Информация в таблице может быть рассортирована по любой из 
колонок (сортировка выполняется после щелчка мыши по заголовку любой из колонок). В случае 
необходимости информация может быть экспортирована в текстовый файл. Для этого необходимо 
щелкнуть правой кнопкой мыши по любой из строк таблицы. 
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7.13. Statistics -> FW Statistics 

Функция предназначена для получения информации о статистике работы межсетевого 
экрана управляемого устройства. Вызов функции предоставляет пользователю информацию о 
статистике работы межсетевого экрана в виде таблицы. Информация в таблице может быть 
рассортирована по любой из колонок (сортировка выполняется после щелчка мыши по заголовку 
любой из колонок). В случае необходимости информация может быть экспортирована в текстовый 
файл. Для этого необходимо щелкнуть правой кнопкой мыши по любой из строк таблицы. 

 

7.14. Statistics -> Memory and Misc 

Функция предназначена для получения информации об использовании памяти на 
управляемом устройстве и другой системной информации. Вызов функции предоставляет 
пользователю информацию об использовании памяти на управляемом устройстве. В случае 
необходимости информация может быть экспортирована в текстовый файл. Для этого необходимо 
щелкнуть правой кнопкой мыши по любой из строк. 

 

7.15. Statistics -> Disk Usage 

Функция предназначена для получения информации об использовании дискового 
пространства на управляемом устройстве. Вызов функции предоставляет пользователю 
информацию об использовании дискового пространства на управляемом устройстве в виде 
таблицы. Информация в таблице может быть рассортирована по любой из колонок (сортировка 
выполняется после щелчка мыши по заголовку любой из колонок). В случае необходимости 
информация может быть экспортирована в текстовый файл. Для этого необходимо щелкнуть 
правой кнопкой мыши по любой из строк таблицы. 

 

7.16. Statistics -> Internal Host Counter 

Функция предназначена для получения информации о лицензированных на управляемом 
устройстве узлах сети. Вызов функции предоставляет пользователю информацию об IP-адресах 
узлов сети подлежащих лицензированию на управляемом устройстве в виде таблицы. 
Информация в таблице может быть рассортирована по любой из колонок (сортировка 
выполняется после щелчка мыши по заголовку любой из колонок). В случае необходимости 
информация может быть экспортирована в текстовый файл. Для этого необходимо щелкнуть 
правой кнопкой мыши по любой из строк таблицы. 

 

7.17. Debug -> VPN Debug 

Функция предназначена для включения и выключения режима отладки процессов связанных 
с обработкой трафика VPN на управляемом устройстве.  

Кроме того, функция предоставляет возможность просмотра журнальных файлов vpnd.elg и 
ike.elg, которые могут быть открыты автоматически при установленном флаге “When I press OK, 
open log file”. 

7.18. Debug -> Certificate Authority 

Функция предназначена для запуска и останова сервиса ICA Management Tool.  
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Доступны следующие настройки ICA Management Tool: 
– Enable SSL – включает использование шифрованного протокола https для ICA Management  
– List of DNs – список пользователей которым разрешено подключаться к ICA Management 

Tool.  
Включив сервис ICA Management Tool, пользователь может подключиться к нему, используя 

Internet Explorer. 

7.19. Debug -> FW-1 Daemons 

Функция предназначена для включения и выключения режимов отладки процессов Firewall-1 
(in.ahttpd, in.aftpd, fwd, и др.) с возможностью выбора уровня отладки. Кроме того, функция 
предоставляет возможность просмотра журнальных файлов *.elg, которые могут быть открыты 
автоматически при установленном флаге Open log file when finished. 

 

8. РЕШЕНИЕ ПРОБЛЕМ 

В случае возникновения проблем, связанных с использованием компонента SPLAT.MD, 
необходимо до обращения в службу поддержки убедиться, что: 

1) порт SSH на управляемом устройстве доступен при обращении с рабочей станции, на 
которой установлен SPLAT.MD; 

2) правильно указана версия управляемого устройства; 
3) выбранная функция применима к типу управляемого устройства; 
4) для идентификатора пользователя правильно указана оболочка bash вместо cpshell. 
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ПЕРЕЧЕНЬ СОКРАЩЕНИЙ 

ПО — программное обеспечение 

SPLAT.MD —  сокращение от SecurePlatform (операционная система компании Check Point
Software Technologies) Management Dashboard 
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